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DESIGN OF MICROSTRIP LOOP ANTENNA WITH BROADBAND
AND MULTIBAND OPERATION FOR WIRELESS

COMMUNICATION

By
Iyad Ali Ibrahim Abu-ALHaj

Supervisor
Dr. Mohammad Kamel Abdelazeez, Prof.

ABSTRACT

In this thesis, microstrip printed loop antenna with area of 10×60 mm2 capable of
generating four resonant modes to form two wide bands centered at about 900 and 2165
MHz to cover all eight operating bands consisting of GSM850/900 and
DCS/PCS/UMTS/WiBro/Bluetooth/Wimax operations, respectively is presented. The
antenna comprises a loop pattern printed on a thin FR4 substrate of small size and a
perpendicular feeding portion printed on the narrow top ungrounded region of the system
circuit board. The proposed antenna is suitable to operate as an internal antenna because the
antenna occupies a small volume inside the mobile phone housing. This thesis presents
detailed design, parametric study and simulation results of the proposed antenna. In
particular, the study will focus on the antenna return loss, gain, antenna efficiency, excited
surface current density, and radiation pattern characteristics of the antenna. To achieve this,
an antenna design software package, called High Frequency Simulation Structure (HFSS)
has been selected to simulate the proposed antenna. It also gives a quick review to the topic
of microstrip antennas and their characteristics, feeding techniques, and literature review
for compact and broadband microstrip antenna.
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Chapter One

Introduction

The progress of wireless communications equipment including mobile phones is ever

accelerating toward implementation of the ubiquitous society, placing more importance to

the antenna technologies day by day. As handsets improve in compactness and functions in

recent years, the antennas for these equipments have come under the spotlight,

transforming their longstanding impression of “an accessory for wireless communications

equipment” into a key device for wireless communication. Naturally, mobile phone

handsets are strongly required to be small in size, but small size is not the only prerequisite.

They are required to have not only essential characteristics for antennas such as bandwidth

and efficiency, but also the suitability for the environment of use specific to mobile phones.

A wide variety of antennas have been used on handsets, but they can be split into the

following categories:

Monopole antenna (whip type): It is shown in Fig.1.1which is the probably the most

widely recognized antennas used for handheld applications and they are often used because

of their classic Omni directional radiation characteristics (Ateef  Z.Elsherbeni, et al., 2002).
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Figure1.1 Monopole antennas on top of a handset (a) Wire monopole, (b) strip monopole,

(c) retractable monopole.

Loop antenna: It is shown in Fig.1.2which provides omni directional type of patterns

and can be integrated into the wireless handsets having a reasonably low-profile

construction. As frequencies increase, the size of the required loop becomes larger relative

to wavelength, and the loop can be matched much easier than the electrically small loop at

lower frequencies. Although the loop has been used primarily with pagers, this higher

frequency usage trend could lead to applications on high frequency wireless handsets in the

future (Ateef  Z.Elsherbeni, et al., 2002).

Figure1.2 Loop antennas for wireless systems (a) Top mounted, (b) case or side mounted,

(c) multiple loop case mounted

Helical Antennas: It is simple wire wound around a uniform cylinder as shown in Fig.

1.3, with multiple turns like a wire-wound spring. This type of antenna, which is based on

the helix used in a traveling wave tube, has an axial mode of radiation and a normal mode

of radiation that perpendicular to the axis of the helix. The axial mode helix has been

widely used as an end fire directional antenna; however, resonant normal-mode helical

antennas are useful as short, vertically polarized radiators, similar to the monopole.
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However, the input impedance of the normal-mode helical antennas is sensitive to changes

in frequency, which results in narrower bandwidth. Even so, the short normal-mode helix

has been widely used in mobile communications systems where a reduced dipole length is

needed (Ateef  Z.Elsherbeni, et al., 2002) .

Figure1.3 Helix antenna on top of a handset

Patch Antennas: It is shown in Fig. 1.4, which is based on printed circuit technology

to create flat radiating structures on top of dielectric, ground-plane-backed substrates. The

appeal of such structures is in allowing compact antennas with low manufacturing cost and

high reliability. It is difficult in practice to achieve this at the same time as acceptably high

bandwidth and efficiency. Nevertheless, improvements in the properties of the dielectric

materials and in design techniques have led to enormous growth in their popularity and

there are now a large number of commercial applications. Many shapes of patch are

possible, with varying applications, but the most popular are rectangular (pictured), circular

and thin strips (i.e. printed dipoles). In the rectangular patch, the length L is typically up to

half of the free space wavelength. The incident wave fed into the feed line sets up a strong

resonance within the patch, leading to a specific distribution of fields in the region of the

dielectric immediately beneath the patch, in which the electric fields are approximately

perpendicular to the patch surface and the magnetic fields are parallel to it. The fields

around the edges of the patch create the radiation, with contributions from the edges adding
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as if they constituted a four-element array. The resultant radiation pattern can thus be

varied over a wide range by altering the length L and width W (Ateef  Z.Elsherbeni, et al.,

2002).

Figure1.4 Microstrip patch antenna.

Planar Inverted-F Antennas (PIFA): The planar inverted–F antenna is popular for

portable wireless devices because of its low profile, small size, and built-in structure. The

other major advantages are easy fabrication, low manufacturing cost, and simple structure.

Also, PIFA’s inherent bandwidth is higher than the bandwidth of the conventional patch

antenna (since a thick air substrate is used). The basic PIFA (a “grounded” patch antenna

/4 patch length instead of the conventional /2) consists of a ground plane, a top plate

element, a feed wire feeding the resonating top plate, and a shorting plate that is connecting

the ground and the top plate at one end of the resonating patch (Wong 2002). Fig.1.5 shows

the geometry of the quarter PIFA.
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Figure1.5 The top view of PIFA structure

1.1The Challenges of Handset Antenna Design

There are many research in this  area attempting  to design antennas suitable to use

for mobile phone where all the published paper focus on four technological tasks to be

overcome at the development of antennas for mobile phone handsets are described below.

Compact size:  to efficiently radiate an electromagnetic wave into free space, the size

of an antenna should basically be something in the order of the wavelength radiated, which

is inversely proportional to the frequency, for example, the wavelength at 900 MHz that is

used in the GSM system is 330mm, which is much larger than the size of the handsets

currently use. One of the features of modern mobile phones systems is low carrier

frequency and broad bandwidth, which makes a major obstacle in the way of antenna

development. It is inevitable in general that the radiation characteristics of an antenna

degrade as the antenna size reduces or the frequency becomes lower. In particular, compact

size and broad bandwidth conflict with each other. Thus, how to downsize an antenna

without degrading its bandwidth is the design policy of great interest when designing

compact antenna.

Multiband operation: Multi-band wireless phone has become popular recently

because they permit people to use the same phone in multi network that have different

frequencies. Table 1.1 lists a few useful wireless applications and their operating

frequencies. Systems that require multiband operation require antenna that resonate at the

specific frequencies. This only adds complexity to the antenna design problem (Hiroyuki

Tamako, et al., 2004).
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Table 1.1: Frequency bands for a few wireless applications

Complete built-in antenna: The sizes and weights of mobile handsets have rapidly

been reduced due to the development of modern integrated circuit technology and the

requirements of the users. Conventional monopole-like antennas have remained relatively

large compared to the handset itself. Thus, built-in antennas are becoming very promising

candidates for applications in mobile handset. Most built-in antennas currently used in

mobile phones are based on planar inverted-F antennas (PIFAs).Such internal mobile

phone antennas usually excite large surface currents on the system ground plane of the

mobile phone, which functions as an effective radiation portion, especially for the lower

frequency operation in GSM-850 and GSM-900. Owing to the large exited surface currents

on the system ground plane, especially in the region near the internal antenna (Hiroyuki

Tamako, et al., 2004).

Frequency bands in  MHzWireless  applications

824-894GSM-850

890-960GSM-900

1565-1585GPS

1710-1880DCS

1850-1990PCS

1920-2170UMTS

2300-2390WiBro

2400-2483Bluetooth

2500-2690Wimax
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Isolation characteristic: The isolation characteristics of an antenna indicate whether its

performance is stabilized or not against the environmental changes. Much importance has

been placed on the isolation characteristics of a mobile phone antenna from the two

viewpoints as shown below. The first relates to the foldable casing consisting of the main

circuit board and display. More specifically, whether or not the same level of

communication sensitivity can be maintained between the two conditions where the casing

is folded or unfolded. The second is concerned with the performance stability against the

influence of the human hand and head. This is a problem specific to handsets, such that the

equipment is used near the head while being held by the hand. Since human body is a loss

dielectric, the electromagnetic waves radiated during the communication are absorbed by

the human body thus considerably degrading the radiation efficiency. There is a general

requirement of improving this efficiency. In response to such a requirement, a design

methodology for compact antennas has been suggested to make use of the ground plane or

the entire casing as a radiator (Hiroyuki Tamako, et al., 2004).

1.2 Microstrip antenna

Microstrip patch antennas have several well-known advantages over other antenna

structures, including their low profile and hence conformal nature, light weight, low cost of

production, robust nature, and compatibility with microwave monolithic integrated circuits

(MMICs) and optoelectronic integrated circuits (OEICs) technologies. Because of these

merits, forms of the microstrip patch antenna have been utilized in many applications such

as in mobile communication base stations, space borne satellite communication systems,

and even mobile communication handset terminals. Unfortunately, the expression, “there is

no such thing as a free lunch,” also applies to microstrip patch technology. Despite the
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previously mentioned features, microstrip patch antennas suffer from several inherent

disadvantages of this technology in its pure form, namely, they have small bandwidth and

relatively poor radiation efficiency resulting from surface wave excitation and conductor

and dielectric losses. A schematic diagram of a microstrip patch antenna is shown in Fig.

1.6. Here an arbitrarily shaped metallic conductor is etched on a grounded dielectric

laminates. A microstrip patch antenna is a resonant-style radiator so one of its dimensions

must be approximately λg/2, where λg is a guided wavelength taking into consideration the

surrounding environment of the printed antenna. It is apparent that the properties of the

substrate, namely, its dielectric constant, εr and its thickness play a fundamental role in the

performance of the printed antenna (Kumar and Ray, 2003).

Figure1.6 Schematic diagram of arbitrarily shaped microstrip patch antenna.

Four fundamental techniques to feed a microstrip patch antenna include edge fed,

probe fed, aperture coupled, and proximity coupled. These can be further simplified into

direct (edge and probe) and non-contact (aperture and proximity-coupled) methods. The

properties of each feeding method are summarized below.

Edge-Fed Patches: One of the original excitation methods for a microstrip patch

antenna is the edge-fed, or microstrip-line fed technique. A schematic diagram representing A
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this method is shown in Fig.1.7. Here a microstrip feed line of width wf is in direct contact

with a rectangular patch conductor of length L and width W.

Figure1.7 Schematic diagram of edge-fed microstrip patch antenna.

Typically the microstrip feed line comes in contact with one of the radiating edges of

the patch, as shown in Fig. 1.7, although cases where the contact is located along the width

of the patch have also been examined. Edge-fed patches have several advantages over other

feeding techniques. One of the key features of this technology is its ease of fabrication,

because the feed layout and patches can be etched on one board. For this reason many large

planar arrays have been developed using edge-fed patches. It is also very easy to control the

level of the input impedance of an edge-fed patch. Simply by inserting the feed into the

patch conductor the impedance at resonance can be adjusted from very high 150 to 250 Ω

when the contact point of the feed line and the patch at the radiating edge of the patch,

down to a couple of ohms if the contact point is near the center of the patch (Kumar and

Ray, 2003).

Edge-fed patches in their simplest form are relatively easy to model, if electrically

thin material is used. Simple transmission line models can be utilized to give estimations of

the input impedance performance of the antenna. For cases when thicker materials are used,

the modeling of the performance is not too straightforward. This is because of the current
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distribution of the discontinuities associated with the contact point between the microstrip

line and the patch antenna (Kumar and Ray, 2003).

Probe-Fed Patches: Probe feeding a microstrip patch antenna is another form of the

original excitation methods proposed in the mid-1970s. A schematic diagram representing

this configuration is shown in Fig.1.8, in which a probe of radius r0 extends through the

ground plane and is connected to the patch conductor, typically soldered to it. The probe or

feeding pin is usually the inner conductor of a coaxial line; hence, probe feeding is often

referred to as a coaxial feed. The probe position provides the impedance control in a similar

manner to inserting the feed for an edge-fed patch. Because of the direct contact between

the feed transmission line and the patch antenna, probe feeding is referred to as a direct

contact excitation mechanism (Kumar and Ray, 2003).

Figure 1.8 Schematic diagram of probe-fed microstrip patch antenna.

The probe-fed patch has several key advantages. First, the feed network, where phase

shifters and filters may be located, is isolated from the radiating elements via a ground

plane. This feature allows independent optimization of each layer. Second, of all the

excitation methods, probe feeding is probably the most efficient because the feed

mechanism is in direct contact with the antenna and most of the feed network is isolated
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from the patch, minimizing spurious radiation. The high efficiency of this printed antenna

has seen a renaissance of the probe-fed-styled patch, despite the added complexity of

developing a connection. Probe-fed microstrip patches have similar issues to edge-fed

patches; namely, their bandwidth is somewhat small and these printed antennas are

somewhat difficult to accurately analyze. The probe used to couple power to the patch can

generate somewhat high cross-polarized fields if electrically thick substrates are used. Also

because this antenna is no longer single-layer geometry, as a result of the location of the

feed network, it is more complicated to manufacture (Kumar and Ray, 2003).

Aperture-Coupled Patches: Because of the shortcomings of the direct contact feeding

techniques, namely, the small inherent bandwidth and the detrimental effect of surface

waves, non-contact excitation mechanisms were introduced. The first of these is the

aperture-coupled patch. A schematic diagram of this printed antenna, as given in Fig.1.9,

shows how separate laminates are used for the feed network and the patch antenna (Kumar

and Ray, 2003).

Figure1.9 Schematic diagram of aperture-coupled microstrip patch antenna.

The laminates are separated by a ground plane and coupling between the feed, in this

case a microstrip line and the patch antenna is achieved via a small slot in the ground plane.
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The configuration shown in Fig.1.9 has advantages over its direct contact counterparts.

Unlike the edge-fed patch antenna, independent optimization of the feed and antenna

substrates can be achieved. Unlike the probe-fed configuration, no vertical interconnects

are required, simplifying the fabrication processes and also adhering to the conformal

nature of printed circuit technology. However, alignment issues can be important and also

multilevel fabrication processes are typically required. A multilayered antenna can create

other problems. The presence of small gaps between the layers of dielectric can

significantly alter the input impedance nature of the antenna, especially at high frequencies,

where these gaps appear larger electrically. Also, the material required to bond the layers

could play a significant role in the performance of the antenna. If the bonding material is

loss and is located near, for example, the slot, the efficiency of the antenna is reduced. The

aperture-coupled patch has more design parameters than the direct contact fed patches and

therefore has more flexibility or degrees of freedom for the antenna designer. Despite its

somewhat complex appearance, the aperture-coupled microstrip patch antenna is relatively

easy to accurately model, even when using full-wave analyses. The reason for this is that

unlike for the direct contact fed patches, there are no abrupt current discontinuities. Thus,

relatively simple, accurate, computationally fast, full wave analyses are easy to develop. In

its original form the aperture-coupled patch has similar bandwidth and gain responses as

the direct fed patches; however, it is very easy to significantly enhance the impedance

bandwidth of this antenna. Aperture-coupled microstrip patch antennas are probably the

most utilized microstrip patches in today’s global market (Kumar and Ray, 2003).

Proximity-Coupled Patches: The second form of non-contact fed patches created to

overcome the shortcomings of the direct contact fed patches is the proximity-coupled patch.

A schematic diagram of this printed antenna is shown in Fig.1.10. The microstrip antenna
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consists of a grounded substrate where a microstrip feed line is located. Above this material

is another dielectric laminate with a microstrip patch etched on its top surface. Please note

there is no ground plane separating the two dielectric layers. The power from the feed

network is coupled to the patch electromagnetically, as opposed to a direct contact. This is

why this form of microstrip patch is sometimes referred to as an electromagnetically

coupled patch antenna (Kumar and Ray, 2003).

Figure1.10 Schematic diagram of proximity-coupled microstrip patch antenna.

A key attribute of the proximity-coupled patch is that its coupling mechanism is

capacitative in nature. This is in contrast to the direct contact methods, which are

predominantly inductive. The difference in coupling significantly affects the obtainable

impedance bandwidth, because the inductive coupling of the edge- and probe-fed

geometries limits the thickness of the material useable. Thus, bandwidth of a proximity-

coupled patch is inherently greater than the direct contact feed patches. As with the

aperture-coupled patch, full-wave analyses are not too difficult to develop for the

proximity- coupled patch because of the lack of a current discontinuity between the feed

network and the radiating element. The proximity-coupled microstrip patch has some
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shortcomings. The feed and antenna layers are not fully independent, because power must

be coupled efficiently to the antenna. Therefore, these printed antennas can have relatively

high spurious feed radiation, although not as high as for an edge-fed case. The antenna is a

multilevel structure and thus alignment procedures are important. Small air gaps between

the feed substrate and the laminate for the antenna can affect the coupling to the patches

and, therefore, care must be taken when fabricating these antennas (Kumar and Ray, 2003).

1.3 Compact and Broadband microstrip antenna

   In order to meet the miniaturization requirements of mobile phones, researchers

have given much attention recently to design compact microstrip antenna with multiband

operation. This section will present the previous works in literature of designing compact

and broadband microstrip antenna in addition to what mentioned in (Wong, 2002) and

(Kumar and Ray, 2003). A novel thin internal GSM/DCS patch antenna for a portable

mobile terminal is reported by (Wong, ea al., 2006), were internal dual-band patch antenna

with a small thickness of 3 mm for application in global system for mobile

communication/digital communication system (GSM/DCS) mobile terminals such as the

mobile phone or personal digital assistant (PDA) phone is presented. The patch antenna

occupies an area of 15×60 mm2, with its top patch embedded with a simple T-shaped slit,

which separates the top patch into two resonant paths to generate two resonant modes for

900/1800 MHz operation. Then, by extending a small portion of the top patch beyond the

top edge of the system ground plane of the mobile terminal, the antenna can provide two

wide bandwidths covering the GSM/DCS bands.

Also, Chih-Hsien Wu and kin-lu Wong (2008) performed a research report to develop

internal shorted planar monopole antenna embedded with a resonant spiral slot for penta
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band mobile phone application. An internal shorted planar monopole antenna embedded

with a resonant spiral slot for GSM850/900/DCS/PCS/UMTS operation in the mobile

phone is presented. The planar monopole is printed on FR4 substrate of small size 10 × 45

mm2. A coupled feed printed on the top no-ground portion of the system circuit board is

used to excite both the planar monopole and the spiral slot to generate two wide bands

covering GSM850/900 and DCS/ PCS/UMTS operation, respectively. The antenna is also

suitable to integrate with the associated electronic components, such as the speaker, to

achieve a compact integration of the antenna inside the mobile phone.

A novel of printed compact S shaped monopole antenna with a perpendicular feed for

penta band mobile phone application was suggested by (Chih-Hsien Wu and kin-lu Wong,

2007) . The S-shaped monopole antenna has a uni-planar structure and can be printed on an

FR4 substrate of small size 10 × 45 mm2 to achieve a compact configuration. By mounting

the antenna over the top edge of the system ground plane of the mobile phone and feeding

it using a perpendicular feed, the antenna occupies a small volume in the top portion of the

mobile phone. This makes it especially suited for application in the thin mobile phone in

which the embedded internal antenna is required to be small in occupied volume and

narrow in width. In addition, the antenna can generate two wide operating bands at about

900 and 2000 MHz to cover the GSM850/900 and DCS/PCS/UMTS operation, respectively.

Research report was performed by (Chun-l Lin and Kin-Lu Wong, 2007) to develop

an internal meandered loop antenna for GSM/DCS/PCS multiband operation in a mobile

phone with the user’s hand. An internal meandered loop antenna for application in a mobile

phone for global system for mobile communication/digital communication System/personal

communication system (GSM/DCS/PCS) multiband operation is presented. Along the

symmetric metal-strip loop structure of the antenna, there are meandered sections for
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adjusting the antenna’s resonant frequencies and widened sections for improving the

impedance matching. The antenna’s first and second resonant modes (half- and one-

wavelength modes) excited at about 900 and 1800 MHz for GSM/DCS operation. With the

meandered sections in the loop structure, the antenna’s third resonant mode (1.5-

wavelength mode) can be adjusted to be close to the second resonant mode at 1800 MHz to

achieve a wider upper band for DCS/PCS operation.

Internal compact dual band printed loop antenna for mobile phone application (Chi

and Wong, 2007) proposes antenna very promising for application in mobile phones as an

internal antenna. The antenna comprises an outer loop strip and an inner inverted-L strip

connected to and enclosed by the outer loop strip. The antenna occupies a compact area of

15 × 50 mm² only, yet generating three resonant modes to form two wide bands at about

900 and 1800 MHz for the global system for mobile communication/digital communication

system operation. When a shielding metal case is placed close to the antenna, small effects

on the antenna’s impedance matching are seen, allowing compact integration of the antenna

with nearby conducting elements or electronic components. The antenna is also found to

result in small excited surface current distributions on the system ground plane of the

mobile phone.

A paper published in June 2009(Wong and Chen, 2009) introduced a modification for

the antenna mentioned in (Chi and Wong, 2007) to be penta band mobile phone

applications instead of dual band with keeping the same area. The antenna is very suitable

to be directly printed on the system circuit board of the mobile phone, making it easy to

fabricate at low cost and generally showing no thickness above the circuit board; the latter

is very attractive for thin profile mobile phone applications. In addition, the proposed loop

antenna is very suitable to be printed at the bottom position of the mobile phone.
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Research report was performed by (Wei-Yu Li and Kin-Lu Wong, 2007)  to develop

an internal printed loop type mobile phone antenna for penta-band operation. An internal

printed loop-type antenna comprising a driven monopole and a coupled strip for application

in GSM850/GSM900/DCS/PCS/UMTS penta-band operation is presented. The antenna is

suitable to be printed on the system circuit board of the mobile phone and short-circuited to

the system ground plane to form as a loop type structure. The antenna provides two wide

bands at about 900 and 1900 MHz to cover to GSM850/ 900 and DCS/PCS/UMTS bands,

respectively. The lower band is generated by the driven monopole and coupled strip

operated together as a half-wavelength loop resonant structure. The upper band is formed

by two resonant modes: the first one is the driven monopole operated alone as a quarter-

wavelength monopole and the second one is contributed from the driven monopole and

coupled strip operated together  as a one-wavelength loop  resonant structure.

In all of the reported works mentioned previously the feeding technique used to excite

the antenna either microstrip line or coaxial cable. In January 2009 a research report was

published by (Wei-Yu Li and Kin-Lu Wong, 2009)  to use a capacitive coupled feed to

excite their antenna. The presence of the capacitively coupled feed leads to a new loop path,

whose length is slightly less than that of the original loop strip. The 0.5, 1.0, and 1.5-

wavelength modes of the new loop path are also excited with good impedance matching.

The two 0.5-wavelength modes of the new loop path and original loop strip form a wide

bandwidth of 310 MHz for the antenna’s lower band to cover GSM850/900 operation. The

other modes of the two loops form a very wide bandwidth of larger than 1 GHz for the

antenna’s upper band to cover GSM1800/1900/UMTS/WLAN/WiMAX operation. With

seven-band operation achieved, the proposed loop antenna only occupies a small volume of
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60×10×3 mm3, and owing to its thin thickness of 3 mm only, and the antenna is very

promising for thin mobile phone applications.

1.4 Organization of the thesis

This thesis consists of four chapters; the first chapter includes the introduction part of

the thesis, the challenges of handset antenna design, microstrip antenna, feeding techniques,

and previous studies explain how to design compact and broadband microstrip antenna.

Chapter two represents the importance and objectives of the study, High frequency

simulation structure (HFSS) and advantages of printed loop antenna. Chapter three

considers the simulation result and the discussion of the return loss, excited surface current

density, antenna gain, antenna efficiency and radiation pattern. Chapter four presents the

conclusions that were reached during this study.
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Chapter Two

Importance and Objectives of the Study

The increasing use of wireless communication systems demand antennas for different

systems and standards with properties like compact, broadband, multiple resonant

frequencies. Because of many attractive features, microstrip patch antennas have received

considerable attention for mobile communication handset terminals. In wireless

communications, for different systems and standards different frequency bands are

allocated such as: DVB-H [470-860 MHz], GSM850 [824-894MHz], GSM900 [890-

960MHz], GPS [1575±10MHz], DCS [1710-1880MHz], PCS [1850-1990MHz], UMTS

[1920-2170], WiBro [2300-2390 MHz], Wireless local area network[ Bluetooth 2400MHz

and IEEE802.11a 5200MHz] and 2.5GHz band [2500-2690MHz] for worldwide

interoperability for microwave access (WiMax) operation.

Applications in present-day mobile communication systems usually require smaller

antenna size in order to meet the miniaturization requirements of mobile units. Thus, size

reduction and bandwidth enhancement are becoming major design considerations for

practical applications of microstrip antennas, also the challenge is to design multi-band

operation antenna. Accordingly; studies to achieve these requirements for microstrip

antennas greatly increased.

A novel  printed loop antenna with a perpendicular feed for penta band mobile

phone application is reported in ( Wong and Huang, 2008) will be chosen as the basis
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structure to adjust it, where a printed loop antenna is described which can be mounted

to the circuit board of the mobile phone for penta-band operation. The antenna

comprises a loop pattern printed on a thin FR4 substrate of small size 10×60 mm2 and a

perpendicular feeding portion printed on the narrow top ungrounded region of the

system circuit board. The antenna occupies a small volume inside the mobile phone

housing and is suitable to operate as an internal antenna. In addition, the antenna

generates two wide operating bands centered at about 900 and 1900 MHz to cover

GSM850/900 and DCS/PCS/UMTS operations, respectively. The configuration of this

reference antenna is shown in Fig. 2.1( Wong and Huang, 2008).

Figure 2.1 (a) Configuration of the printed loop antenna with a perpendicular feed for
mobile phone application. (b) Dimensions of the loop pattern and the perpendicular feeding
portion. (c) The printed loop antenna enclosed by a 1 mm thick mobile phone plastic
housing.
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In this study, we will adopt an enhancement for the antenna proposed in ( Wong and

Huang, 2008), while maintaining the same size of the antenna proposed in ( Wong and

Huang, 2008); by increasing the operating bands to include three bands cover WiBro,

Bluetooth and Wimax to become proposed antenna for eight band wireless applications. By

changing the location of perpendicular feeding portion, adjusting the dimensions of the

central tuning section, and feeding portion in Fig. 2.1. A parametric study will be

performed for the proposed antenna in order to choose best dimensions of the antenna.

The configuration of the proposed printed loop antenna with a perpendicular feed is

shown in Fig. 2.2. The loop pattern is printed on a 0.8-mm thick FR4 substrate of size

10×60mm2; the printed loop pattern is then mounted in perpendicular to the top edge of the

system circuit board (a 0.8mm thick FR4 substrate of size 60×104 mm2 used here). The

dimensions of the loop pattern are shown in Fig. 2.2 (c) and (d). Through the via-holes at

points E and F, the loop pattern is connected to the feeding portion at points C and D

printed on the top ungrounded region (size 60×4mm2) of the system circuit board. A ground

plane of width 60 mm and length 100 mm (L) is printed on the back side of the system

circuit board as the system ground plane. The FR4 substrate used here has a relative

permittivity of 4.4 and a loss tangent of 0.0245, and the selected sizes of the system ground

plane and circuit board are for the possible applications of the proposed antenna in the

general PDA phone or smart phone.

One end of the feeding portion is the feeding point (point A) of the antenna, which is

connected to the 50 Ω microstrip feed line printed on the system circuit board. The other

end (point B) of the feeding portion is grounded to the top edge of the ground plane through

a via-hole in the system circuit board. From point A, through points C, E, F, and D, then to

A
ll 

R
ig

ht
s R

es
er

ve
d 

- L
ib

ra
ry

 o
f U

ni
ve

rs
ity

 o
f J

or
da

n 
- C

en
te

r  
of

 T
he

si
s D

ep
os

it



www.manaraa.com

22

point B. Fig. 2.2(b) shows the printed loop antenna enclosed by housing of the mobile

phone. The mobile phone housing is fabricated using a 1-mm thick acrylonitrile butadiene

styrene (ABS) plate with relative permittivity of 3.5 and a conductivity of 0.02 S/m in this

study. The ABS is a practical material for the housing of general mobile phones. The

housing can avoid direct contact of the user’s hand with the antenna and the system ground

plane ( Wong and Huang, 2008).
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Figure2.2 The configuration of the proposed antenna (a) Three dimension for the proposed

antenna. (b) Side view for the proposed antenna. (c) Top view for the proposed antenna. (d)

Front view for the proposed antenna.
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2.1 Advantages of the printed loop antenna

This type of printed loop antenna’s has two features are mentioned and described

below.

Effects of the ground plane size: The varying of ground plane length has a large

effect for unbalanced mode on the impedance characteristics. For a decreased ground plane

length, the excitation of the unbalanced mode quickly becomes degraded the impedance

characteristics. But the printed loop antenna shows an attractive feature of performing as a

balanced structure when operated at its one-wavelength resonant mode. This property can

lead to smaller antenna performance degradation.

Research report was performed by (Wu and Wong, 2002 ) to present an experimental

study of the impedance bandwidth of the PIFA for a UMTS mobile handset. Fig. 2.3 shows the

configuration of the PIFA mounted on the top portion of a ground plane of length L and width

W, which can be considered to be the ground plane of a mobile handset.

The PIFA shown in Fig. 2.3 with various ground-plane lengths and widths was

experimentally studied. Fig. 2.4 shows the measured return loss against frequency for the

PIFA with various ground-plane lengths of 65-90 mm. It is clearly seen that the measured

return loss is significantly affected by the variation in the ground plane length.

It is observed that in Fig. 2.5, for L varying from 50 to 105 mm, the obtained

impedance bandwidths vary from about 210 to 490 MHz, a variation of over 300%. The

optimal impedance bandwidth occurs at about L=65 mm, which corresponds to be about

45% of the free-space wavelength at 2050MHz, As for the center operating frequency

shown in Fig. 2.5(b), the variations in the ground-plane length also cause a variation of
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about 70MHz, from about 2045 to 2115 MHz. Fig. 2.6 shows the effects of various ground-

plane widths on the measured impedance bandwidth and the center operating frequency. It

is seen that both the impedance bandwidth and the center operating frequency are increased

monotonically with decreasing ground-plane width.

Figure 2.3 Geometry of a planar inverted-F antenna for a UMTS mobile handset

(a)Top view (b) Side view
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Figure 2.4 Measured return loss for the antenna shown in Fig. 2.3 with W=30 mm.

Figure 2.5 Measured (a) impedance bandwidth and (b)center operating frequency for the

antenna shown in Fig.2.3 with W=30 mm
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Figure2.6 Measured (a) impedance bandwidth and (b) center operating frequency for the

antenna shown in Fig. 2.3with L=65 mm.

Effects of excited surface current density: Recently, it has been demonstrated in a

scientific research that the loop antenna is very promising for achieving dual-band or multiband

operation in the mobile phone. Although these loop antennas are mainly operated as half-

wavelength and one-wavelength structures, unlike the conventional quarter-wavelength planar
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inverted-F antennas (PIFAs) for mobile phones, they still can be configured to occupy a

compact volume inside the mobile phone for multiband operation. Such internal loop antennas

also show an attractive feature of performing as a balanced structure when operated at its one-

wavelength resonant mode. In this case, the excited surface currents on the system ground

plane of the mobile phone will be greatly suppressed. This property can lead to smaller antenna

performance degradation when the mobile phone is held by the user’s hand / or attached to the

user’s head ( Wong and Huang, 2008).

Hisashi Morishita, Yongho Kim and Kyohel Fujimoto (Morishita, et al., 2002)performed

a study to compare between the antenna’s performances for balanced loop antenna and

unbalanced loop antenna by example. This study a small rectangular loop antenna, which has

small and low profile, as shown in Fig. 2.7.  An analysis has shown a remarkable reduction in

the currents on the ground plane. This is shown in Fig. 2.8 where Fig. 2.8a and 2.8b show the

current distributions on the ground plane and the antenna element in the balanced and the

unbalanced system, respectively. The radiation patterns have also been analyzed, and are

shown in Fig. 2.9. The patterns of both unbalanced and balanced systems are shown, for

cases where the effects of both the human head and hand are included. In this analysis, the

models of the human head and hand shown in Fig. 2.8 and Fig. 2.9 give evidence that the

balanced system is more useful compared to the unbalanced system, because of the much

lower current flowing on the ground plane, and because of smaller influences on the

patterns due to the human head and hand models. This fact suggests that the human-body

effect on the antenna’s performance in small mobile terminals would be made very small,

when an antenna system is made with a balanced structure.
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Figure 2.7 (a) A balanced loop antennas for a handset

Figure 2.7 (b) An unbalanced feed for the loop of Figure 2.7 (a)

Figure 2.7 (c) A balanced feed for the loop of Figure 2.7 (a)
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Figure 2.8 (a) The current distribution on the antenna system of Figure 2.7a for an

unbalanced feed

Figure 2.8 (b) The current distribution on the antenna system of Figure 2.7a for a balanced feed

(The color scale is the same as shown in Fig. 2.7 a)

Figure 2.9 (a) The radiation pattern for the unbalanced system of Figure 2.7a without a

human model: —Eф (calculated); o Eф (measured); …. EӨ (calculated); x EӨ (measured) A
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Figure 2.9 (b) The radiation pattern for the balanced system of Figure 2.7a without a

human model.

Figure 2.9 (c) The radiation pattern for the unbalanced system of Figure2.7a with a human

head model.

Figure 2.9 (d) The radiation pattern for the balanced system of Figure 2.7a with a human

head model
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Figure 2.9 (e) The radiation pattern for the unbalanced system of Figure 2.7a with a human

hand models

Figure 2.9 (f) The radiation pattern for the balanced system of Figure 2.7a with a human

hand models

2.2 Objective of the Study and the HFSS

In particular, the study will focus on the antenna return loss, gain, and the excited

surface current distribution on the system ground plane (to evaluate the effect of the near

antenna  by conducting elements, and the user’s hand effect). Another study will consider

the radiation pattern characteristics of the antenna, which is required to be “Monopole-like”
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pattern. To achieve this, an antenna design software package, called High Frequency

Simulation Structure (HFSS) has been selected to develop and to simulate this proposed

antenna. Nowadays, antenna engineers can rely on highly specialized full wave

electromagnetic field solvers to develop and optimize their designs. Computer-aided

analysis and optimization have been replaced the design process of the iterative

experimental modifications of the initial design.

Ansoft HFSS is based on finite element method (FEM). Its first formulations were

developed as matrix methods for structural mechanics (Vasylchenko, et al., 2009). This

lead to the idea to approximate solids, and in 1942, Courant introduced an assembly of

triangular elements and the minimum of potential energy to torsion problems. The first

paper on the application of FEM to electrical problems appeared in 1968. The main concept

of FEM is based on subdividing the geometrical domain of a boundary-value problem into

smaller sub-domains, called the finite elements, and expressing the governing differential

equation along with the associated boundary conditions as a set of linear equations that can

be solved computationally using linear-algebra techniques. The matrices tend to be large,

particularly

in three dimensions, but are very sparse, unlike the full matrices generated by Mom. Since

for large problems, most of the computational time is consumed by the solution of the

matrix equation, it is very important to use a technique that takes full advantage of the

sparsely. In HFSS, the final elements are introduced as tetrahedrons: four-sided pyramids.

Each element can contain a different material. Therefore, the interface between two

different materials must coincide with element boundaries. This contributes the ability to
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treat geometrically very complex structures with inhomogeneous and anisotropic materials

to FEM.

Two mesh operations can be manually controlled by the user in HFSS (Ansoft Corporation

HFSS):

 Length-based mesh refinement: refines the length of tetrahedral elements on a

surface or within a volume until they are below a certain value.

 Skin-depth-based mesh refinement: refines the surface triangle length of all

tetrahedral elements on a surface or volume to within a specified value.
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Chapter Three

Simulation Results and Discussions

The configuration of the proposed antenna as shown in Fig.2.2 contains several

variables. Changing these variables affect the antenna parameters performance (return loss,

gain, radiation efficiency, radiation pattern). The main reason of this study is the design of

an internal antenna for mobile phone to cover the largest possible number of operating

bands. Therefore, the final dimensions of the proposed antenna shown in Fig.2.2 identified

by using parametric study in order to cover eight operating bands GSM850/900,

DCS/PCS/UMTS/WiBro, Bluetooth, and Wimax.

3.1 Parametric Study

I have used the HFSS to determine antenna parameter performance and the final

dimension for the proposed antenna. The return loss used to determine the operating

band(s) in which antenna can be utilized. The internal antennas of the mobile phones

usually designed based on the bandwidth definition of 6 dB return loss (3:1 VSWR) (Wong

and Huang, 2008). Results of the return loss variation as a function of the width w are

presented in Fig.3.1. Small effect on the antenna’s first, second and third resonant mode are

seen, and large effects on the antenna’s fourth resonant mode. In order to cover the

DCS/PCS/UMTS/WiBro, Bluetooth, and Wimax, the width w is selected to be 8 mm. In

addition, I study the effect of adjusting a and b on the return loss. From Fig.3.2, we notice

that changing a and b significantly affect the fourth resonant mode. Thus, the preferred

values of a and b to cover DCS/PCS/UMTS/WiBro, Bluetooth and Wimax is chosen to be

a = 1mm and b =1 mm.
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Figure3.1   Effects of adjusting of the width of the side tuning section w on the return loss

Figure3.2   Effects of the adjusting of “a” and “b” on the return loss

The variation of the return loss as a function of P, the length of feeding portion, is

shown in Fig.3.3. Results indicate that the variable P affects the second, third and fourth

resonant modes. Thus, the value of P is selected to be 15mm to cover

DCS/PCS/UMTS/WiBro, Bluetooth, and Wimax. A
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Figure3.3 The variation of the return loss as function of P, the length of the feeding portion

Finally, effect variation of u, top ungrounded region is demonstrated in Fig.3.4. When u=

5mm the third resonant mode is disappeared whereas when u=3mm third resonant mode is

shifted to uncover DCS/PCS. Thus, the better value of u is selected to be 4mm to cover all

applications in upper band.

Figure3.4 The variation of the return loss as a function of u, the top ungrounded region
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Accordingly, the final dimensions of the proposed antenna were adopted to be as

shown in Fig.2.2. The variation of the return loss for the proposed antenna compared to that

of (Wong and Huang, 2008 )is shown in Fig.3.5. Using the 3:1 VSWR (6 dB return loss)

as reference value, which is generally used for the internal mobile phone antenna design,

the lower band shows a bandwidth of 151 MHz (818-969 MHz) centered at first resonant

mode around 900MHz, allowing the antenna to cover GSM850/900 operation. While the

second, third and fourth resonant modes occur at about 1700, 1936 and 2500 MHz,

respectively. They are  responsible for generate the upper band has a bandwidth of 1182

MHz (1574-2756 MHz) centered at around 2165 MHz, which satisfies the required

bandwidth for DCS/PCS/UMTS/WiBro, Bluetooth and Wimax.

Figure3.5 The variation of the return loss for the proposed antenna and the reference

antenna

3.2 The Antenna Parameters Performance

The simulated radiation pattern for all resonant modes  are shown in Figs.3.6, 3.7, 3.8,

and 3.9 which seem  to be similar to that of monopole antenna with  nulls occurring  at
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some angels such as  0°, 90°,-90°, 180°,-180°. The antenna gain and radiation efficiency,

the radiation efficiency is the ratio of the radiated power to the accepted power, for

reference antenna in (Wong and Huang, 2008)and proposed antenna, are presented in

Fig.3.10 and 3.11, respectively. The reference antenna gain for lower band varies from 1.14

to 1.59 dBi whereas the lower band gain for proposed antenna varies from 1 to 1.58 to dBi.

The radiation efficiency of reference antenna in (Wong and Huang, 2008) for the lower

band varied from 60 to 85 % whereas the radiation efficiency of proposed antenna for the

lower band varied from 71.8 to 79.8 %.

  (a)

A
ll 

R
ig

ht
s R

es
er

ve
d 

- L
ib

ra
ry

 o
f U

ni
ve

rs
ity

 o
f J

or
da

n 
- C

en
te

r  
of

 T
he

si
s D

ep
os

it



www.manaraa.com

41

       (b)

      (c)
Figure3.6   Radiation pattern for f = 900 MHz for the proposed antenna —Eф, ----EӨ.
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       (a)

  (b)
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             (c)
Figure3.7   Radiation pattern for f=1700MHz for the proposed antenna —Eф, ----EӨ

(a)
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                 (b)

           (c)
Figure3.8   Radiation pattern for f = 1936 MHz for the proposed antenna —Eф, ----EӨ.
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                                                              (a)

(b)
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(c)
Figure3.9 Radiation pattern for f=2500MHz for the proposed antenna —Eф, ----EӨ
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Figure3.10 The variation of the antenna gain for the lower band
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Figure3.11 The variation of the radiation efficiency for the lower band

The variation of the antenna gain and radiation efficiency for the reference antenna

(Wong and Huang, 2008) and proposed antenna, for the upper band, is shown in Figs.3.12

and 3.13, respectively. The reference antenna gain for upper band varied from 1.5 to 3.6

dBi whereas the lower band gain for proposed antenna varied from 2.3 to 5 dBi. The

radiation efficiency of reference antenna in (Wong and Huang, 2008) for the upper band

varied from 66 to 77 % whereas the radiation efficiency of proposed antenna for the lower

band varied from 63 to 75 %.
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Figure3.12   The variation of the antenna gain for the upper band
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Figure3.13 The variation of the radiation efficiency for the upper band
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3.3 Effect of the Ground Plane Size

The variation of the return loss for different values of the length of the ground plane L

(from 30 to 100 mm) is shown in Fig. 3.14. For the antenna’s second and third resonant

modes, only some slight frequency shifting is observed; which indicate that the decreased

ground plane length shows small effects on the excitation of the balanced mode.

Nevertheless, the first and fourth resonant mode has large effects, which is an unbalanced

mode. This behavior is very similar to PIFA’s internal antenna mobile phone mentioned in

the previous chapter. This phenomenon results from the excited surface currents density on

the system ground plane of the mobile phone at balanced modes are weaker than at

unbalanced modes.

Figure3.14 Simulated return loss as a function of L, the length of system ground plane.
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Chapter Four

Conclusion

In this study, I adopt the reference antenna in (Wong and Huang, 2008) as basis

structure. The reference antenna presents a novel printed loop antenna on a thin FR4

substrate that can be mounted perpendicular to the top edge of the system circuit board with

small size 10×60 mm2 to occupy a small volume inside the mobile phone housing. The

reference antenna capable of generating three resonant modes, first resonant mode occur at

900MHz, it’s responsible for generating the first wide operating band centered at about

900MHz to cover GSM850/900 MHz operations, while the second, and third resonant

mode occur at 1700,2050MHz. They responsible for generating the second wide operating

bands centered at about 1900 MHz to cover DCS/PCS/UMTS operations.

All reported research tries to get the largest possible number of operating bands with

smallest size without significantly affecting the antenna parameter performance. In my

thesis, I worked to modify the structure of reference antenna while keeping the same size to

cover the largest possible number of applications. I used the HFSS in order to achieve this

modification. There are several variables in the basis structure. These variables can be

controlled by using parametric study to reach the final dimensions of the proposed antenna.

The modification of proposed antenna  consist  of changing the location of perpendicular

feeding portion, adjusting the dimensions of the central tuning section,  and length of

feeding portion  for the reference antenna in (Wong and Huang, 2008) . The proposed

antenna  capable of generating  four resonant modes, the first resonant mode occur at

900MHz, it’s  responsible for generating the first wide operating band centered at around
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900 MHz to cover GSM850/900 operations, while the second, third, and fourth resonant

mode occur at 1700,1936,2500MHz, respectively. They responsible for generating the

second wide operating band centered around 2165MHz to cover

DCS/PCS/UMTS/WiBro/Bluetooth/Wimax operations. In the lower band, the gain and

radiation efficiency for the proposed antenna more than the gain and radiation efficiency

for the reference antenna from 820-850 MHz and 930-960MHz, while the gain and

radiation efficiency for the proposed antenna less than gain and radiation efficiency for the

reference antenna from 850-930 MHz. In the upper band, the gain for the proposed antenna

less than the gain for the reference antenna from 1700-1800 MHz and 2050-2200 MHz,

while the gain for the proposed antenna more than the gain for the reference antenna from

1800-2050MHz and 2200-2700MHz.The radiation efficiency of the proposed antenna less

than the radiation efficiency of the reference antenna from 1700-2700MHz. In addition, the

proposed antenna has small-excited surface current density on the system ground plane.

This feature can lead to smaller antenna performance degradation when the mobile phone is

held by the user’s hand/or attached to the user’s head.
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Appendix A

HFSS is a high performance full wave electromagnetic field simulator for arbitrary

3D volumetric passive device modeling that takes advantage of the familiar Microsoft

windows graphical user interface. It integrates simulation, visualization, solid modeling,

and automation in an easy to learn environment where solutions to your 3D EM problems

are quickly and accurately obtained. Ansoft HFSS employs the finite element method,

adaptive meshing, and brilliant graphics to give you unparalleled performance and insight

to all of your 3D EM problems. HFSS is an interactive software package for calculating the

electromagnetic behavior of a structure (Ansoft Corporation HFSS).Using HFSS, you can

compute:

• Basic electromagnetic field quantities and, for open boundary problems, radiated near and
far fields.

• Characteristic port impedances and propagation constants.

• Generalized S-parameters and S-parameters renormalized to specific port impedances.

• The eigenmodes, or resonances, of a structure.

The steps that have been followed to create, simulate, and analyze a proposed antenna
in this thesis:

Launching Ansoft HFSS

To access Ansoft HFSS, click the Microsoft Start button, select Programs, and select the

Ansoft, HFSS 10 program group. Click HFSS 10

Setting Tool Options

To set the tool options:

A
ll 

R
ig

ht
s R

es
er

ve
d 

- L
ib

ra
ry

 o
f U

ni
ve

rs
ity

 o
f J

or
da

n 
- C

en
te

r  
of

 T
he

si
s D

ep
os

it



www.manaraa.com

55

1. Select the menu item Tools > Options > HFSS Options

2. HFSS Options Window:

        a. Click the General tab

 Use Wizards for data entry when creating new boundaries: √Checked

 Duplicate boundaries with geometry:√ Checked

        b. Click the OK button

3. Select the menu item Tools > Options > 3D Modeler Options.

4. 3D Modeler Options Window:

          a. Click the Operation tab

 Automatically cover closed polylines: √Checked

2. Click the Drawing tab

 Edit property of new primitives: √Checked

3. Click the OK button

Opening a New Project

To open a new project:

1. In an Ansoft HFSS window, select the menu item File > New.

2. From the Project menu, select Insert HFSS Design.

Set Solution Type

To set the solution type:

1. Select the menu item HFSS > Solution Type

2. Solution Type Window:

a. Choose Driven Modal

      b. Click the OK button
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Creating the 3D Model

 Set Model Units

To set the units:

1. Select the menu item 3D Modeler > Units

2. Set Model Units:

       a. Select Units: mm

       b. Click the OK button`

 Set Default Material

To set the default material:

1. Using the 3D Modeler Materials toolbar, choose Select

2. Select Definition Window:

       a. Type FR4 in the Search by Name field

       b. Click the OK button

 Creating Box#1

1. Select the menu item Draw>Box.

2. Using the coordinate entry fields, enter the Box position

             X:0     Y:0        Z:0

3. Using the coordinate entry fields, enter the opposite corner of the box:

                  dX:10    dY:60           dZ:0.8

                4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: horizontalsubstrate

c. Click the OK button
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 Creating Box#2

1. Select the menu item Draw>Box.

2. Using the coordinate entry fields, enter the Box position

             X:5.4    Y:0        Z:0

3. Using the coordinate entry fields, enter the opposite corner of the box:

                  dX:0.8    dY:60           dZ:-104

4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: verticalsubstrate

c. Click the OK button

 Set Default Material

To set the default material:

1. Using the 3D Modeler Materials toolbar, choose Select

2. Select Definition Window:

       a. Type copper in the Search by Name field

       b. Click the OK button.

 Creating rectangles

 Create side tuning left

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:0       Y:0        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

             dX:10    dY:8           dZ:0
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                     4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: sidetuningleft

c. Click the OK button

 Create Loopwidth#1

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:0       Y:8        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

             dX:1      dY:19           dZ:0

                     4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: Loopwidth1

c. Click the OK button

 Create Feedleft

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:0       Y:27        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

             dX:6      dY:2           dZ:0

                     4.To set the name:

                         a. Select the Attribute tab from the Properties window.
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                         b. For the Value of Name type:Feedleft

c. Click the OK button

 Create FeedRight

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:0       Y:31        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

         dX:6      dY:2           dZ:0

                     4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type:FeedRight

c. Click the OK button

 Create Loopwidth#2

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:0       Y:33        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

  dX:1      dY:19           dZ:0

4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: Loopwidth2

c. Click the OK button
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 Create side tuning right

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:0       Y:52        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

    dX:10    dY:8           dZ:0

4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: sidetuningright

c. Click the OK button

 Create Loopwidth#3

1. Select the menu item Draw>rectangle.

2. Using the coordinate entry fields, enter the rectangle position

             X:10       Y:52        Z:0

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

           dX:-1      dY:-42           dZ:0

                     4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: Loopwidth3

c. Click the OK button

 Create groundplane

1. Select the menu item Draw>rectangle.

A
ll 

R
ig

ht
s R

es
er

ve
d 

- L
ib

ra
ry

 o
f U

ni
ve

rs
ity

 o
f J

or
da

n 
- C

en
te

r  
of

 T
he

si
s D

ep
os

it



www.manaraa.com

61

2. Using the coordinate entry fields, enter the rectangle position

             X:5.4       Y:0        Z:-4

3.Using the coordinate entry fields, enter the opposite corner of the

rectangle:

           dX:0      dY:60           dZ:100

                     4.To set the name:

                         a. Select the Attribute tab from the Properties window.

                         b. For the Value of Name type: groundplane

c. Click the OK button

Group Conductors

 To group the conductors:

1. Select the menu item Edit>select>Byname

2. Select Object Dialog:

a. select the object named:sidetuningleft,Loopwidth1,Feedleft,

Feedright, Loopwidth2, sidetuningright, Loopwidth3

 Note: use the ctrl+left mouse button to select multiple objects

b. Click the OK button

3.Select the menu item, 3D Modeler> Boolean>Unite

Create the Lumped  port

To create a rectangle  that represents the port:

1. Select the menu item Draw > Rectangle

2. Using the coordinate entry fields, enter the rectangle position

                                        X: 4.6, Y: 14.25, Z: -104, Press the Enter key
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3. Using the coordinate entry fields, enter the opposite corner of rectangle:

                                      dX: 0.8, dY: 1.5, dZ: -104, Press the Enter key

To set the name:

1. Select the Attribute tab from the Properties window.

2. For the Value of Name type: port

3. Click the OK button

Create Lumped Port Excitation

To select the object port:

        1. Select the menu item Edit > Select > By Name

2. Select Object Dialog,

             a. Select the objects named: port

             b. Click the OK button

To assign wave port excitation

1. Select the menu item HFSS > Excitations > Assign > Lumped Port

2. Lumped Port : General

          a. Name: p1,

          b. Click the Next button

3. Lumped Port : Terminals

           a. Number of Terminals: 1,

           b. For T1, click the Undefined column and select New Line

            c. Using the coordinate entry fields, enter the vector position

X: 4.6, Y: 15, Z: -104, Press the Enter key

            d. Using the coordinate entry fields, enter the vertex

A
ll 

R
ig

ht
s R

es
er

ve
d 

- L
ib

ra
ry

 o
f U

ni
ve

rs
ity

 o
f J

or
da

n 
- C

en
te

r  
of

 T
he

si
s D

ep
os

it



www.manaraa.com

63

             dX: 0.8, dY: 0.0, dZ: 0.0, Press the Enter key

            e. Click the Next button

5. Wave Port : Post Processing

Reference Impedance: 50

6. Click the Finish button

Analysis Setup

 Creating an Analysis Setup

To create an analysis setup:

1. Select the menu item HFSS > Analysis Setup > Add Solution Setup

2. Solution Setup Window:

          a. Click the General tab:

Solution Frequency: 0.9 GHz

Maximum Number of Passes: 20

Maximum Delta S per Pass: 0.02

            b. Click the OK button

 Adding a Frequency Sweep

To add a frequency sweep:

1. Select the menu item HFSS > Analysis Setup > Add Sweep

          a. Select Solution Setup: Setup1

         b. Click the OK button

2. Edit Sweep Window:

       a. Sweep Type: Fast

       b. Frequency Setup Type: Linear Step

Start: 0.5GHz
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Stop: 3GHz

Stop size: 1MHz

Save Fields: √ Checked

c. Click the OK button

Save Project

To save the project:

1. In an Ansoft HFSS window, select the menu item File > Save As.

2. From the Save As window, type the Filename: Proposedantenna

3. Click the Save button

Analyze

 Model Validation

To validate the model:

1. Select the menu item HFSS > Validation Check

2. Click the Close button

Note: To view any errors or warning messages, use the Message Manager.

 Analyze

To start the solution process:

 Select the menu item HFSS > Analyze All
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